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DOS & WINDOWS OPERATING SYSTEMS

1.0 INTRODUCTION

A working machine requires an extensive set of instructions to control its operations. These instructions
are collectively known as software. The instructions which control what a computer does in response to command
of a user are normally handled in two sets. One set of instructions controls the system under which the computer
operates fixing the d=tailed movement and handling of information. This set is called the operating system. The
second set, known as the application software, allows the user to call up instructions which support a given tasks
rather than to the operation of the computer.

System software is a series of programs written to simplify the interface between the programmer and
the computer hardware. System software is generally composed of an operating system (OS), language
translators, utilities. data management and data communication systems. The OS functions as an office manager
for the computer system.

The overall purpose of the OS is to control the activities of the computer system. It serves as the traffic
cop, directing and managing computer events. In addition, the OS provides a useful interface that allows the user
to concentrate on what he wants to accomplish, rather than on the details of how the computer internally carries
it out. Three of the major functions of an OS are overall master control, resource management, and monitoring
activities. The tremendous demand for computing power, the need for increased reliability, and the decreasing
price of hardware have led to the design of computer systems that have multiple processors and the OS for these
machines.

Some popular operating svstems are MS-DOS, 0S/2 and UNIX. While there hasn’t been any official
committee that has specified indusuy parameters, several de-facto standards for microcomputer OS have
developed. A de-facto standard is one that vendors informally accept. generally because it has come to dominate
a market segment of the business. For the PCs, it is the DOS operating system. In some computers, OS is being
implemented in firmware, as permanently coded instructions within a ROM.

A critical point to understand is that application programs or software packages such as payroll, word
processing, and spreadsheet are designed for use with a specific OS. In turn, most OS are designed for usc with
a particular micropre zessor. In generzl. the application software is not portable. That is, it cannot be used with
just any computer svstem. However. zfforts are bring made to develop systems such that the applications can
be ported across a range of platforms. In the following, MS-DOS and WINDOWS operating systems shall be
discussed in detail.

2.0 MS-DOS

MS-DOS or the Micro Soft Disk Operating System consists of a group of programs which has the
following functions:

© to monitor commands given by the user to the computer,

© to load and gexecute programs specified by the user,

© to manage the devices attached to the computer,

o to manags the files of data and programs that the computer will work with.

The MS-DOS is a single users OS which means that only one user can use the computer at a time. It

allows the user to entzr the commands in upper case letters, lower case letters or a combination of both. All the
DOS commands are terminated by [Enter] key. The important commands of DOS are described below :
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ATTRIB Command
This command allows to set the read attributes of a file to read-only or to display the attributes of a file.
The syntax is :
[path]ATTRIB [+R | -R] [+A | -A] [+S | -S] [+H | -H] [path]filename.ext /S
where,
[path] before ATTRIB specifies the path of the ATTRIB command file.

+ Sets an attribute.

- Clears an attribute

R Read-only file attribute

A Archive file attribute

S System file attribute

H Hidden file attribute

/S Processes files in all directories in the specified path

filename. ext File whose attributes are to be modified.

BACKUP Command
This command backs up one or more files from a disk to another disk. The drive specifiers of the disks

must be different. The syntax is :

[path]BACKUP d:[path]filename d: [/S][/M][/D:mm-dd-yy]
where,
[path] before BACKUP specifies the path of the BACKUP command file.
d:[path]filename specifies the filenames to be backed up.(Source)
d: specifies the drive that will contain the backed up files.(Destination)
/S is used to backup all the files in all the subdirectories in addition to the files in the specified
directory. ‘
/M is used to backup files that have been modified since the last backup.
/D is used to back up files that have been modified on or after the specified date. The format of the date
specified will be mm-dd-yy.

CD Command
This command changes the working directory. The syntax is :

CD <directory_name>

e.g
CD ‘IRCC
will set the working directory as \IRCC.

CHKDSK Command

It shows the space available on a hard disk or floppy. The syntax is:
CHKDSK

CLS Command
This command clears the screen.

COPY Command
This command copies the contents of one file to the other file. The syntax is:

COPY <file_one> <file_two)
eg.
COPY ABC.EXT XYZ.EXT

As a result of the above command there will be two files in the directory with same contents but with
different names ABC.EXT and XYZ.EXT.
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DATE Command
This command is used to change the date known to the DOS. The syntax is:

DATE [mm-dd-yy]
where,
mm-dd-yy specifies the date in month-day-year format.

DEL or ERASE Command
It deletes selected files. The syntax is:

DEL <filename.ext>
or )
ERASE <filename.ext>

e.g.
DEL RAJEN.BAK
will delete the file RAJEN.BAK from the current directory.

DELTREE Command

This command can be used to delete a directory along with all the files and subdirectories. The syntax
is :

DELTREE c:\fortran
DIR Command

It gives the information about the file like, file name, extension, size of the file in bytes and date and
time the file was last edited. e.g.

DIR
will display all the file in current directory.

DIR/P
will display directory, pausing after every screenful to enable the user to examine the list.

DOSKEY Command

This command loads the DOSKEY ( a memory resident program) in the memory. Doskey can be used
to recall/ edit the previously used commands by using the arrow keys on the keyboard. To load Doskey, at the
DOS prompt type :

[path)]DOSKEY

MD Command
This command is used for creating a directory in the current directory. The syntax is:

MD <Directory name>
e.g.

MD IRCC

will create a subdirectory IRCC in the current directory.
PATH Command

This command sets specified directories for commands or batch files that were not found by a search
of the current directory. The syntax is :

PATH [pathl;path2....... 1

A list of drives and path names, separated by semicolons can be specified.

NATIONAL INSTITUTE OF HYDROLOGY, ROORKEE

3



DOS and Windows Operating Systems

PRINT Command
This command prints a file. The syntax is :

PRINT <filename >

PROMPT Command
This command is used to set a new DOS prompt. The syntax is :

PROMPT [prompt text]

RD Command
This command is used for deleting a directory or sub directory. The syntax is:

RD <directory name>
The directory being deleted should not contain any file i.e. the directory should be empty.

RENAME Command
It changes the name of selected file. The syntax is:

RENAME <oldfile_name> <newfile_name>

e.g.
RENAME ABCD.FOR KKK .FOR
will rename the file ABCD.FOR to KKK.FOR.

RESTORE Command
This command restores one or more backup files from a disk to another disk. The syntax is :

[path]RESTORE d:[/S]

where,
[path] is the path of the RESTORE command file.
d: is the drive that contains the backup files.
/S is used to restore all files in all the subdirectories in addition to the files in the specifies directory

SYS Command

This command transfers the operating system files from the first drive specified to the second drive
specified. The syntax is :

[path]SYS d:
where,

|path] before SYS specifies the path of the SYS command file and

[d:] specifies the disk drive where the operating system files are to be transferred
TIME Command

Whenever any file is created or modified, the time of creation/modification of that file is recorded in
the system. This command permits to change the time known to the system. The syntax is :

TIME [hh:mm:ss]

where, hh specifies the hours, mm specifies the minutes and ss specifies the seconds.
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TREE Command
This command displays all of the directory paths found on the specified drive, and optionally lists the
files in each subdirectory. The syntax is:

[path]TREE d:][/F]
where,
[path] before TREE specifies the path of the tree command file
[d:] specifies the drive whose directory paths are to be displayed and
[/F] is optionally used to display the names of the files in the subdirectories.

TYPE Command
It displays the contents of an ASCII file on the screen. The syntax is :

TYPE <filename.ext>
eg.
TYPE RAJEN.DAT
will display the contents of file RAJEN.DAT on screen.

XCOPY Command
This command copies file (except hidden and system files) and directory trees. The syntax is :

XCOPY source [destination] [ /D:date] [/P] [/S [/E]] [/V] [/W]

where,
source the files to copy
destination the location of new files.
/D copies files changed on or after the specified date
/P prompts before creating each destination file
/S copies directories and subdirectories except empty one
/E copies any subdirectories, even if empty
AY verifies each new file
A% prompts the user to press a key before copying

Changing the Drive
To change the drive tvpe the drive name followed by colon( : ) sign (without any blank). e.g.
A:
The default drive will be A: now.

Halting the rushing text

When a program puts out many-lines of data in rapid succession the user need a way to stop the flow
of text so that it can be read before it rolls off the screen. Press [Ctrl] and [S] keys simultaneously for halting
the flow of text. Press any kev to restart the flow of text.

Copying file from one floppy to other floppy
When system contains only one floppy drive, floppy swapping is necessary, e.g. if a file is to be copied
from "X’ floppy to ’Y’ floppy. with floppy "X" is in drive A, type the following :

COPY A:<filename> B:
As a result the file <filename> will be copied from floppy X to floppy Y.

For copying the whole floppy, DISKCOPY command is used which also formats the target floppy. The
syntax is:

DISKCOPY A: B:
It will format the target floppy and copy all the files from A drive to B drive.
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Copying file from floppy to directory on hard disk
Insert floppy in drive A and type:

COPY A:<filename> c:<directory name>

eg.
COPY A:** ¢c: IRCC

will copy all the files of floppy to IRCC directory.

The user may note that the exact command syntax and behaviour may slightly change from one version
of the DOS to other.

MS-DOS Diagnostics and MS-DOS Antivirus Utilities

MS-DOS Diagnostics (MSD) provides the detailed technical information about the computer. MS-DOS
Antivirus (MSAYV) can protect the data by detecting more than 800 different viruses and removing them from
the system. It also includes VSAFE. a memory resident program that monitors the computer and warns of
changes that might have been caused by a virus

Configuring the System
To configure the system, the user sets it up so that MS-DOS, hardware and the applications work in
the way required. Most of the system’s configuration information is stored in two files :

CONFIG.SYS is a text file that contains commands that configure the computer’s hardware components
(Memory, keyboard. mouse, printer and so on) so MS-DOS and other applications can use them. When the MS-
DOS starts, it carries out the commands in CONFIG.SYS file first.

AUTOEXEC.BAT file is a batch program that MS-DOS runs immediately after carryving out the commands in
the CONFIG.SYS. The AUTOEXEC.BAT can contain any DOS command that is to be executed when the
system is started e.g. commands that define the path, run your favourite menu program etc.

These two files are typically located in the root directory of the boot disk. The commands of the
CONFIG.SYS are as follows :

Command Purpose

break Specifies whether MS-DOS should check periodically for the CTRL+C or
CTRL+BREAK key combination.

buffers Specifies how much memory MS-DO0S reserves for transferring information to and from
disks.

country Sets the language conventions for your system.

device Loads an installable device driver program that controls a hardware component, such as
a mouse or memory board.

devicehigh Loads an mstallable device driver into the upper memory area.

dos . Specifies whether MS-DOS will use the high memory area (HMA) and whether it will
provide access to upper memory blocks (UMBs).

files Specifies how many files can be open at a time.

install Loads a memory-resident program (also called a terminate-and- stay-resident program,
TSR).

lastdrive Sets the number of valid drive letters.

numlock Specifies whether the NUM LOCK setting of the numeric keypad is initially on or off.

rem Indicates that the text that follows is a descriptive remark, not a command. It can also
used to disable a command.

set Sets the value of environment variables such as PROMPT or TEMP

shell Configures COMMAND.COM or specifies that a command interpreter other than
COMMAND.COM should be used.
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The following is a typical CONFIG.SYS file for a 80386 computer with 2 or more MB of extended
mMemory :

device = ¢:\dos\setver.exe
device = c¢:\dos\himem.sys
device = c:\dos\emm386.exe ram
devicehigh = c:\mouse\mouse.sys
buffers =20

files = 40

break = on

dos = high,umb

3.0 MS WINDOWS 3.1
31 INTRODUCTION

The Windows is a GUI (Graphical User Interface) combined with support of standardized methods.
Instead of being a full operating system, Microsoft had originally developed Windows as an add-on over MS-
DOS. However, the Windows-95 has been developed as a full fledged OS.

3.1.1  What is WINDOWS?

Windows is an operating environment. It can be called user interface methodology where user need
not concern himself with how windows work, because the goal of windows application developers is to use the
windews environment with more visible continuity. The user can do most of the usual chores by making
selections from the menus and need not remember or type the various commands. Extensive on-line help is
available to guide him at the various stages.

3.1.2 Why Use WINDOWS?
Some reasons why windows is becoming popular around the world, are:

[t is an easy-to-use, consistent GUI for virtually all programs.

It is capableof multitasking (running several programs simultaneously). Graphics programs and

character based programs can be run concurrently.

> Program Manager can be used to switch easily between multiple program.

s With windows, user can communicate and exchange data between programs without
transferring or copying files.

- As file and disk-management are simple and readily available, a user need not close and open
programs or use DOS commands to do standard file and disk-maintenance chores.

° Windows can run applications that offer high quality output.

s Many specific purpose and utility programs are bundled with windows. For example, a word

processor (Write), a drawing program (Paintbrush), a scheduler (Calendar) etc.

y O

3.1.3 Requirements to Run WINDOWS

Windows runs on two operating modes depending upon hardware configuration.
(@) For PC 386 enhanced mode:
A personal computer with a 386 processor or higher having:
o 640 K conventional memory,
1024 K extended memory,
8-MB of free disk space, 10 MB recommended,
One floppy disk drive.

o 0 .0
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(i) For Standard mode:
A personal computer with a 286 processor or higher or 386 that has less than 2-MB of free Memory
having :
640 K of conventional memory, °
256 K of extended memory,
6- MB of free disk space,
One floppy disk drive,
A display adapter that is supported by windows,
A printer that is supported by windows,
A mouse that is supported by windows,
A modem if terminal is to be used for windows application.

08000

o000

3.1.4 Running Programs Simultaneously

Depending on available hardware, doing several tasks simultaneously is made easy through windows.
For example, when the user switches from painting program to word processor he has to exit the painting
program, go to MS-DOS and then start the word processor. Leaving programs can be slow; starting programs
usually is even slower. With windows, switching between programs takes small time.

3.1.5 Communication Among WINDOWS Programs

Two major methods for passing information are clipboard and OLE (Object Linking and Embedding).
Most of interprogram communication is done through the clipboard.

(i) Clipboard
Clipboard is a buffer or holding area in system memory that contains one piece of data at any one time.
Read and write is done through standard commands.

(i) OLE (Object Linking & Embedding)

OLE is a method for passing data directly between programs without having to use the clipboard. It
can be thought of as a telephone network on which one program can dial another program and pass on certain
types of information.

3.1.6  Starting and Leaving Windows

(i) Starting windows:
Start the windows with WIN command from the appropriate directory at the MS-DOS prompt:

C> WIN
It automatically runs Program Manager.

(ii) Running programs as you start windows:
If the user provides the name of program on MS-DOS command line, WINDOWS starts that program
rather than the Program Manager:

C : > WIN \WORD35\WORD
This will start the windows and then the word program from the WORDS directory.

(iii) Leaving Windows:
As windows is an operating environment and is not a single program, it requires a DOS shell to run:

0 When user exits from other windows programs, control returns to program manager. When the

program manager is in the front window, give the Exit command in the file menu or press Alt-
F4.

NATIONAL INSTITUTE OF HYDROLOGY, ROORKEE
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o When user closes Program Manager he is presented with a dialog box confirming that he wants
to leave windows. Press OK to leave windows. To resume working in windows press Cancel
or Esc key.

3.1.7 Menus and Commands

The most common way 10 tell windows what user wants to do is by choosing a command from a menu.
Every windows program has at ]least one menu and most have four or more. The menu bar is at the top of the
program window. The Program Manager menu bar has the following pull down menus :

i |

Elipses and Check Marks

In some commands. elipses (_ _ ) follows the command name. In file menu the commands such as
New, Move, Copy etc. have eclipses but others like Open and Delete do not. An elipse indicates that the
command does not execute directly. Some more information is needed for its execution. The command displays
a dialog box through the user can make additional choices or supply the requisite information before the

command executes.

Sometimes commands have 2 check mark to their left. The check mark indicates that the particular
marked command is currently active of selected. The check mark is absent when the command is unselected or
when it is inactive. Check marks are ON/OFF indicators and are sometimes called toggles.

3.2 MAIN WINDOWS MANAGER PROGRAMS

3.2.1  Program Manager

o]

Program Manager organizes user programs into groups.

o The central program from which user can Tun other programs is the windows Program
Manager.
o The user sees this program running when he first starts windows and again when he is about

to leave windows.
Its features is 1ts flexibility.

When windows starts it looks like as in Fig.1
mwwywman

SREAR R S
The screen background Each of these areas
'lhmnuslmm. is a wiics.

T Program ManageT
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@ User can easily change the wayvs programs appear in Program Manager, rearrange the
programs, add new ones, remove old ones and so on.

@ User can configure how programs should run whether they should run at the start and what
documents to open when program starts.

Afterinstallation, the Windows has five program groups (holding related programs), represented by their
icons. These are as follows:

o Start-up o Main © Accessories
o Application © Games

Menus in Program Manager

The four menus of Program Manager are File, Options, Windows and_Help. The File menu is
displayed in Fig. 2.

F7
F8

Del
Alt + Enter

Fig. 2. File Menu

File Menu
The various commands of the file menu are explained in Table 1.

Table - 1
Command Function
New Creates new program groups and icons.
Open Opens the application icon that has a high-lighted text.
Move Moves icon from one group to another.
Copy Makes a copy of a highlighted icon from one group in
another desired group.
Delete Removes the selected icon or group permanently.
Run Starts an application or opens a document.
Exit Windows Command to leave windows.

Options Menu

The Options menu is shown in Fig. 3.

Minimize on Use
Save Settings on Exit

Fig.3 . Preferences chosen from options menu.
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The various commands of the options menu are explained in Table 2.

Table - 2
Command Function
Auto Arrange Arranges icons automatically.
Minimize on Use Causes the last program used to change to an icon
Save settings on Exit Indicates whether changes to windows environment
will be saved upon exit.

Window Menu .
The Window menu is used to arrange the appearance of icons and is shown in Fig. 4.

Window

Cascade Shift + F5
Tile Shift + F4
Arrange Icons

o Main o Startup o Applications
o Games o Accessories

Fig.4 : The Window menu with main group chosen.

The various commands of the window menu are explained in Table 3.

Table - 3
Command Function
Cascade Displays the window opened below and to the right of each
other.
Tile Divides the screen equally between the opened windows.
Arrange Icons Enables the space icons manually.
Available Groups List of the program groups available for use in windows.

Help Menu
This menu is shown in Fig. 5. Its commands are explained in Table 4.

Contents
Search for Help on _ _ _

How to use Help
Windows tutorial
About Program Manager_ _ _

Fig.5. Help Menu of Program Manager.
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Table - 4
Command Function
Contents ‘Displays a table of topics covered in Help.
Search for Help Shows a detailed alphabetical list of topics in Help from which
on user can make a choice.
How to use Provides tips and techniques to use Help.
Help On-line lessons to know the windows basics.
Windows tutorials Information about the user’s Copy of Program Manager, its
About program operating mode, memory capacity and available system resources.

3.2.2  File Manager

o]

O

File manager can be started from the Program Manager by double clicking
its icon in the Main group window.

File manager provides a graphical representation of files and directories and
help the user 10 organize and simplify file maintenance.

The directory window is divided by the split bar. The left side of the
window displays the structure of the current drive, or the directory tree. The
right side of the window displays a list of files in the selected directory as
seen in Fig.6.

User can use the drive icons on the drive bar to choose what drive is
displayed in a directory window.

Status bar displays information about the current drive and directory and
other information that helps explain the task user is performing with File

Manager.

The Menu bar contains menus listing File Manager Commands.

Tasks performed by File Manager
With the File manager, a user can.

¢
&
¢
¢
C\
¢
¢
Q
¢
1%

View the contents of directories.

Move, copy and delete files and directories.

Change to other disk drives, including network drives.

Format and maintain disks.

Print documents.

Start an application.

Rename and delete files.

Change the kind and amount of information displayed about each file.
Create directories and subdirectories.

Search for files.

3.2.3 Print Manager

The Print Manager is an application included with Windows that the users can use to manage docum
sent to a printer and can install and configure printers, as shown in Fig. 7. Whenever a user prints from a
windows based application. the application creates a print file and sends it to Print Manager. Print Manager
works in background. sending users documents 10 the printer while the user can continue working. The user can

check the status of the document at any time and change its status until it starts printing.
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As user sends documents to Print Manager, a print queue forms. The point queue displays the following
printer information :

The name of the printer.

The port printer is connected to and, if it is a network printer, the network path.

The current status of the printer (such as native or idle).

Beneath the printer information, the print queue displays the following document information.
The title of the document.

The document’s position in the queue, or a printer icon if the document is printing.

The size of the document in kilobytes (if the Print file size command has a check mark next
to it).

The time and date user sent the document to Print Manager.

If a document is currently printing, the amount (as a percentage) of the document printed so
far.

L& LLHLLD

&b

To Pause printing

o In print Manager window, select the name of the printer to be paused.

o Choose the Pause button, Or press ALT + P.

To Resume printing

o In print Manager window, select the document or the name of the printer you want to resume printing.
o Choose the Resume button. Or press ALT + R.

To Cancel printing

o In print manager, select the document whose printing is to be cancelled.
o Choose the Delete button. Or press ALT + D. A dialog box appears, prompting to confirm the
deletion.

3.3 OTHER PROGRAMS THAT COME WITH WINDOWS

Write a word processor that can prepare letters, reports and articles.

Paintbrush a painting program that can create colour or black & white drawings.

Calendar an appointment calendar that helps a user organize his time and alerts when important events
are about to take place.

Cardfile an organizing program that a user can use to store and search for information.

Terminal a communications program for connecting the users’ PC to other computers through a
modam.

=D Calculator a desk calculator that can replace the old pocket model.

& dd

&

3.4 KEYBOARD SHORTCUTS
A user can use keyboard shortcuts to do common windows tasks.

3.4.1  Using Help

To Press
Start Help F1
Move among jumps in aotopic TAB or SHIFT + TAB
Display all the jumps in a topic or Ctrl + TAB
cancel the selection of a jump
Copv a Help screen or annotation ALT + PRINT SCREEN
into the clipboard
Quit Help ALT + F4

NATIONAL INSTITUTE OF HYDROLOGY, ROORKEE
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3.4.2 Switching between Applications

3.4.3

3.4.4

3.4.5

To switch
Between applications

To the next application

To the previous application

To task list

An MS-DOS based application from
a full screen to a window and back

Using Menus

To
Activate the menu bar
Select a menu
Choose a menu command

Open the control menu for an
application window

Open the Control menu for a
document window and a group
window.

Moving Around

To move
Between meanu commands,

characters in a text box, or items in a list.

To next or previous dialog box item
To a dialog box item

Right or Left one word in a text box

To beginning or end of a line,
list, or screen
Up or Down one screen

Selecting Items

In a Document Window

To select
One line of text up or down

Text to the beginning or end of a
document

DOS and Windows Operating Systems

Do this

Press and hold down ALT or SHIFT + ALT and
repeatedly press TAB

Press ALT + ESC

Press SHIFT + ALT + ESC

Press Ctrl + ESC

Press ALT + ENTER

Press

ALT or F10

ALT + the underlined character in the menu name

An arrow key, ENTER or the under-lined characterin the
command name.

ALT + SPACE BAR

ALT + HYPHEN

Press
An arrow key

TAB or SHIFT + TAB

ALT + the characterunderlined in the item name.
Ctrl + an ARROW key.

HOME or END

PAGE UP or PAGE DOWN

Press

SHIFT + UP ARROW or SHIFT +DOWN
ARROW

SHIFT + Ctrl + HOME or

SHIFT + Ctrl + END

In a Document Window, Text Box, or List

To Select

Text to the beginning or end of a line

The next or previous word

One letter at a time to left or right

Press

SHIFT+HOME or SHIFT+END

SHIFT + Ctrl + Right Arrow or SHIFT + Ctrl +
Left Arrow

SHIFT + Left Arrow or SHIFT + Right Arrow

NATIONAL INSTITUTE OF HYDROLOGY, ROORKEE
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3.4.6

3.4.7

3.4.8

3.4.9

3.4.10

In a Dialog Box
To Select
Select nonconsecutive items in a list

Select a list item or check box
Select all items in a list

Cancel all selections in a list except
the current one

Editing Text

In a Text Box or Window

To

Delete the character to the left or
right or delete selected text.
Copy selected text into the clipboard
Move selected text into the clipboard
Paste text from the clipboard
Undo the last editing action

Copying Onto the Clipboard

To
Copy an image of the entire screen
onto the clipboard.
Copy an image of the active window
on to the clipboard.

Quitting an Application & Closing a Window

To
Quit an application
Close the active document window
or group window.

Program Manager
To
Move between groups
Move between items in a group window
Start the selected application or restore
the selected group icon.
File the group windows
Cascade the group windows
Close an active group window

File Manager

To
Move among the left and right side of
the directory window and the drive bar.
Change the drive displayed in the

Display or hide a selected directory’s
subdirectories, start a selected appli-
cation, or open a selected file.

NATIONAL INSTITUTE OF HYDROLOGY, ROORKEE
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Press

SHIFT + F8, Use arrow key to move item to be
selected, press SPACEBAR to select item, press
SHIFT + F8 again.

SPACEBAR

Ctrl + SLASH (/)

Ctrl + BACKSLASH ()

Press
BACKSPACE or DEL

Ctrl+ C or Ctrl + INS

Ctrl + X or SHIFT + DEL

Ctrl + V or SHIFT + INS

Ctrl + Z or ALT+BACKSPACE

Do this
Press PRINT SCREEN

Press ALT + PRINT SCREEN

Press
ALT + F4
Ctrl + F4

Press

Ctrl + F6 or Ctrl + TAB
An arrow key

ENTER

SHIFT + F4
SHIFT + F5
Ctrl + F4

Do this
Press TAB or F6

Press Ctrl + the letter representing directory
window. d
Press ENTER



Open a new window, display only the
contents of the selected directory.
Select the next file or directory whose
name begins with a certain character
Move the selected file or directory.
Copy the selected file or directory.
Update the information displayed.

DOS and Windows Operating Systems

Press SHIFT + ENTER

Press the first character or file
or directory name. Press F7.

Press F8
Press F5

Display the properties of the selected Press ALT + ENTER

file or directory.

3.4.11 Print Manager
To Press
Move between queues and between Up Amow or Down Amow
documents in each queue.

Move the selected document up or Ctrl + UP ARROW or

down in a queue. Ctrl + DOWN ARROW
Update the information displayed Press F5
3.4.12 Write
To Do this

Press C+Z or ALT+BACKSPACE
Press Ctrl + ENTER
Press Ctrl + SHIFT + HYPHEN

Undo the last typing or editing action
Insert a manual page break

Insert an invisible hyphen

(only to be used when a word is wrapped).
Switch between the document and

Find or Replace dialog box or between
the Header and Footer window and the
Page Header or Page Footer dialog box.

Press ALT + F6

4.0 WINDOWS-95
4.1 Introduction

The Windows-935 is an operating system, it bypasses DOS and runs completely in protected mode. It
can however stop brieflv in real mode at start up to process the now-optional CONFIG.SYS and
AUTOEXEC.BAT, to load TSRs and old device drivers. With Windows-95 INI files will be a history, crucial
configuration details like user preferences, hardware settings and security are stored in the Registry - a database
user can distribute across a Windows-93 network. The OS also expands and contracts its cache buffer space to
match available memory - thus ending swap-file tinkering and cache memory problems. The Windows-95 is 32-
bit operating system but Microsoft has left some 16-bit code in so that it can run on 4MB systems.

4.1.1 What’s on Windows-95 Screen

Depending upon how the computer is set up, various items appear on desktop whenever the Windows
is started.

* My Computer : By double clicking this icon, computer contents can be seen and files can be managed.

% Network Neighbourhood : By double clicking this icon, the user can see available resources on the network,
if the computer is connected to any of the network.

#* Recvele Bin : The Recycle Bin is a temporary storage place for deleted files. User can use it to retrieve files
deleted in error.
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% Start button : The user can click start button on the task bar to start a program, open a document, change
system settings, get Help, find items on computer.

4.1.2 What’s new in Windows-95?
The Windows-95 offers many new exciting features. Some of the import features are :

o New improved interface
Windows now features the start button and taskbar.
Start button: It quickly opens programs, find documents, and use system tools.
Task bar : It is used to switch between programs as easily as changing channels on T.V.

© Windows Explorer:
Windows Explorer is a powerful way to browse through and manage files, drivers and network
connzctions.

o Long Filenames:
Windows now supports long filenames to make files easier to organize and find.

o Improved Games & Multimedia Support:
Faster video capability for games, enhanced support for MS-DOS based games, and improved
performance for playing video and sound files.

o Plug and Play Hardware Compatibility:
The user can just insert the card for plug and play hardware in the computer. When he turns on the
computer, windows recognizes and sets up hardware automatically.

o 32-bit Preemptive Multitasking:
The Windows provides using many programs at once : do more in less time.

© Microsoft Exchange:
It is used to view and work with all types of electronic communications, including e-mail and faxes.

o The Microsoft Network:
User can use on-line service to communicate with people worldwide, using e-mail. bulletin boards and
the Internet.

4.2 GETTING STARTED WITH WINDOWS 95
4.2.1  Logging on to Windows
o In the User Name box, type your name.

In the Password box, type a password. The first time, Windows prompts user
to confirm his password.

e

4.2.2 The Start button and taskbar

The start button and taskbar are located at the bottom of screen when Windows starts for the first time.
By default they are always visible when Windows is running.

Starting with the Start Menu

When user clicks on Start button a Menu comes which contain everything that is needed to begin using
Windows as seen in Fig. 8.
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This Command Do this

Programs Displays a list of programs to start.

Documents Displays a list of documents opened previously.

Settings Displays a list of system components for which settings can be changed.

Find Enables to find a folder, file, shared computer, or mail message.

Help Starts Help. User can use help contents, Index, or other tabs to find out how
to do a task in Windows,

Run Starts a program or opens a folder when user type an MS-DOS command.

Shut down Shuts down or restarts computer, or logs off.

Depending on Computer and the options user have chosen, user may see additional items on his menu.

To start a Program
(i) Click the start button and then point to Programs.
(ii) Point to the folder such as Accessories that contains the program, and then click the program.

Opening a Document
There are several methods to open documents in Windows. Two methods are described below:

A. To open document from within program:
i) On the file menu, click open.

i) To open a document in different folder, click the arrow next to the look in box, and then click
the disk that contains the folder.

iii) Click the folder that contains the document to be open and then click open. Scroll to see more
folders.

iv) Click the document to open, and then click open.

B. To open a Document bv using the Documents menu:
i) Click the start button, and then point to Documents.
i) Click the name of document to be opened.

Changing Svstem Settinos:
Using the Control Panel, the user can change the way Windows looks and works.

i) Click the start button and the Point to Settings.
ii) Click Control panel.
iii) Double-click an icon to see the settings user can change.

Finding Something on Computer :
When the user doesn’t know where a document or folder is he can use find command to find and open

it.
i) Click the start button and then point to Find.
if) Click files or Folders.
iii) Click the Named box, and then type the name of the file or folder which is to be found.

iv) To specifv where to search, click the arrow next to the look In box, or click Browse.
V) To start the search, click Find Now.
Getting Help :

On line help is essential for learning and using Windows. There are two kinds of Help : Help about
a specific procedure and Help that gives information about what is on the screen.

A. To find Help through the contents :
. Click the contents tab to find topics grouped by subject, and then follow the instructions on screen.
. To return to the list of topics, click Help Topics.
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B. To find Help through the Index:
. Click the Index tab to find topics listed alphabetically and then follow the instructions on screen.
. To return to the list of topics, click Help topics.

C. To find Help topics containing a word or phrase:
: Click the Find tab to find all topics that contain a specific word or phrase, and then follow instructions
on screen.

D. Ta get Help on a specific Item:
. For information about an item in a dialog box, click? and then click the item.
. A pop-up explanation appears. Click it to make it disappear.

Starting a Program by Using the Run Command:
When the user knows the path of the program he wants to start, he can use run command to start it

easily.
o Click the Start button and then click Run.
o Type the name of the program, folder, or document user want to open. Or click Browse to
look for the item.

Shutting Down Computer:
To avoid damaging files, always shut down Windows before turning off Computer.

o Click the start button, and then click shut down.
Click Yes. If the document has not been saved, the windows prompts to save changes.
A screen message lets user know when he can safely turn off his computer.

O

(8]

The Task Bar : :

Everv-time user starts a program or open a window, a button representing that window appears on the
taskbar. To switch between windows, just click the button for the window that is required. While closing a
window, its button disappears from the task bar.

Depending on what task user is working on, other indicators can appear in the notification area on the
task bar, such as printer representing print job or a battery representing power on portable computer. At one
end of the taskbar is the clock. To view or change settings, just double click the clock or any of the indicators.

4.3 ORGANIZING FILES AND FOLDERS
4.3.1  To move or Copy a file or folder

Double click "My Computer", Find the file or folder user want to move or copy, and then click
1t.
C Click Edit:
- To move the file, click cut.
- To make a copy of the file, click copy.
Open the folder where user want to place the file, click Edit, and the click Paste.

O

4.3.2 To delete a file or folder

C Double-click My Computer. Find the file or folder you want to delete, and then click it.
C On the File menu, click Delete.
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4.3.3

4.3.4

4.4

4.4.1

4.4.2

4.5

4.5.1

DOS and Windows Operating Systems

To create a new folder

Double click My Computer, and then double-click the disk drive or folder in which user wants
to place the new folder.

On the File menu, point to New, and then click Folder.

Type the name of the new folder and then press ENTER.

[8)

Q.0

To copy a file to a floppy disk

e Double-click My Computer. Find the file or folder user want to copy and then click it.
o} On the File Menu, point to Send To, and then click the drive where user want to copy the file

or folder.
PRINTING

Setting up printer for use with Windows

- Click the start button, point to settings, and then click Printers.

- Double-click Add Printer,

- Follow instructions on Screen.

- After the setup is completed, the icon for printer appears in the Printers
folder & printer is ready for use.

Printing a Document
- If the document is open, click File and then click Print.
- Double-click the printer icon in the printer folder to see the documents that
are printing or waiting to print, and to manage printing. User can pause or
cancel the printing of one or more documents.

SHORTCUT KEYS

The following keyboard shortcut keys can be used with Windows:

To Press

See Help on the selected dialog box item F1

Quit a program ALT+F4
View the shortcut menu for the selected item SHIFT+F10
Display the Start menu Ctrl+ESC
Cut Cul+X
Copy Ctrl+C
Paste Ctrl+V
Delete DEL

Undo Cul+Z

For the Desktop, My Computer, and Windows Explorer

When an item is selected, the following shortcut keys can be used:

To Press

Rename an item F2

Find a folder or file F3

Delete immediately SHIFT + DEL

View item properties ALT+ENTER or ALT+double-click
Copy a file Ctrl key while dragging the file
Create a shortcut Cud+SHIFT while dragging the file
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Toggle Toggle Keys on and off NUMLOCK for 5 seconds
Toggle Mouse Keys on and off LEFT ALT + LEFT SHIFT + NUMLOCK

Toggle High Contrast on and off LEFT ALT + LEFT SHIFT + PRINT
SCREEN 4
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Fig. 6 : File Manager

You use the Pause and Resume buttons
to temporarily stop and restart printing.
You can cancel a print job by selecting
it and then choosing the Delete button.
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